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Introduction 

Find out how to use data lists and Pivot tables to extract, manipulate and analyse 
information in Excel 2016. Familiarity with Windows and a working knowledge of Excel, as 
found in the Introduction to Excel course, is required. 

Objectives 

On successful completion of this course participants will be able to: 

• Create a pivot table 

• Apply filtering to pivot table data 

• Use grouping tools to combine pivot table results 

• Create calculated fields within a pivot table 

• Create Pivot Tables and Charts to manipulate data. 

• Work with Data Models to integrate data from multiple tables 
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Excel: Pivot tables 

1 Using a Pivot table or Pivot chart to analyse data 

A Pivot table is an interactive table that displays two-dimensional summaries of selected 
data from a list.  You can rotate its rows and columns, filter the data by displaying different 
pages, or display the details for areas of interest - thus enabling lots of different 
summarised views of the same data.  You can create a Pivot table from any tabular sheet 
or database that includes rows or column headings and data in the cells following. 

a. Creating a Pivot table Report 

1 Open the 1 – Create Pivot Table.xlsx file from your practice folder 

2 Place your selection anywhere within the table of data 

3 On the Insert tab, Tables group, choose Pivot table  
 

 
 
The data range 'Sales Data'!$A$1:$F$500 should be selected in the Table/Range: 
field 

4 Check that the Choose where the Pivot table is to be placed setting is set to New 
Worksheet. 
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5 Click OK 
 

 

6 The Pivot table outline now appears 

7 The Pivot table task pane also appears – 
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b. The Pivot table tab 

When working with a Pivot table, if your cursor is located in the table, a new tab appears 
(Pivot table Tools), with 2 sub-tabs (Analyze and Design) – 

 Analyze 

 

 

From this group you can give the Pivot table a name 
and select options for what is displayed (e.g. grand 
totals for rows/columns, how zero values should be 
displayed) 

 

 

This group displays the active field in the table and, if 
possible, allows you to expand to see further detail 
relating to a field, or when it is visible, collapse that 
detail 

 

From here you can group or ungroup selected fields 

 

From this group you can refresh the data in the table 
after changes have been made to the original data 

 

This group gives you options for clearing, selecting 
and moving the Pivot table 

 

The Calculations group allows you to change how you 
are summarising values in your table, create custom 
calculations to show your values in relation to other 
rows and columns in the table and create and modify 
calculated fields 

 

This group offers extra tools, including the option to 
create a Pivot chart 
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On/off buttons changing how the table displays 

 Design 

 

This offers numerous options for altering the format/look of the table 

c. Layout a Pivot Table 

The way that you layout a pivot table will affect the calculations that are performed.  This is 
controlled from the PivotTable Fields dialog box. 

Decide how you want your table to display by dragging field name buttons from the top 
and placing them at the relevant points, either in the table itself, or any of the four layout 
areas at the bottom of the task pane 

 The layout of the task pane itself can be changed at - 
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 Σ Values 

If you drag a field into the Σ Values area some form of calculation will occur.  The content 
of the fields will determine the default calculation. Should the field contain numerical data, 
the calculation will automatically be a SUM, should the filed contain text or a mixture of 
data it will perform a COUNT.   

1 Drag the Sales field (numerical data) into the Σ Values area 
 
Observe the calculation that has occurred 

2 Drag the Salesperson field (text) into the Σ Values area 
 
Observe the calculation that has occurred 

3 Drag the Count of Salesperson field from the Σ Values area and drop it either back 
in the fields list or outside the PivotTable Fields pane altogether 

 Rows and Columns 

If you drag fields into the Rows or Columns area the pivot table, the data will be 
subdivided by the labels contained within that field.  For this to be effective you need to 
have a field that contains recurring data labels. 

1 Drag the Salesperson field into the Rows area from the Fields list above 
 
Observe the changes made to the pivot table 

2 Drag the Year field into the Columns area 
 
Observe the changes made to the pivot table 

3 Drag the Region field into the Rows area, drop it just above the Salesperson field 
that is already there 
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Observe the changes made to the pivot table 

4 Drag the Car Type field below the Salesperson field  
 
Observe the changes made to the pivot table 

5 Click on the Car Type field 
 

 

6 From the menu that appears click Remove Field 
 
You can also remove a field by dragging it out of the areas all together. 

d. Rename a Pivot Table 

Like Tables you may name a Pivot Table which then allows you to reference it in formulas 
and when using other features.  There are some rules around how you name a PivotTable, 
for instance: 

• The PivotTable name may not begin with a number, letter or symbol 

• The name cannot contain spaces 

To rename our Pivot: 

1 If it is not open, click on the Analyze Tab 
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2 From the PivotTable group click the PivotTable Name: text box 
 

 

3 Type “sales_pivot” 

4 Hit “ENTER” 

e. Change the Calculation 

By default, when you place a field into the Σ Values area either a SUM calculation (in the 
case of a field containing numbers) or a COUNT calculation will occur.  However, this may 
not be the calculation that you wish to see.  Changes to how a field is presented in the 
PivotTable is controlled by the Field Settings.  

1 Click any of the figures in the Sum of Sales area of your PivotTable 
 

 

2 In the Analyze ribbon, observe that the Active Field is the Sum of Sales. 
 

 

3 Click the Field Settings. control just below. 
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The Value Field Settings dialogue box will appear.  The Summarize value field by 
control allows you to select the calculation that will be performed in the PivotTable 

4 Select Average from the list 
 
Notice that the Custom Name: control has changed to Average of Sales 

5 Edit the Custom Name: to read just “Average” 

6 Click OK 
 
Observe the result  

7 Click the Field Settings control again. 

8 Change the Summarize value field by setting to Sum 

9 Click the Show Values As tab 

10 Try selecting % of Parent Row Total 

11 Click OK 
 
Observe the result 

12 At the far-right side of the screen, drag the Sales field from the list to the Σ Values 
area 
 
Notice that you now have two columns of results for each year 

f. Show Details (Drilling down) 

When you analyse your data with tools such as PivotTables, it is not uncommon to notice 
results that are unusual or interesting.  Drilling down into your data can be done using the 
Show Details tool. 
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1 Click on one of the totals in the open pivot table to select it 

2 Right click the cell 

3 From the menu that appears select Show Details 

4 Observe the new table of data that is created 

Note: You can do the same simply by double clicking on the cell that you are interested in. 

2 Refresh Pivot Tables 

a. Refresh 

1 Open the 2 - Refresh Data.xlsx file 

2 Click on the Refresh tab to select the worksheet 

3 Note the Grand Totals for the PivotTable 

4 Click the Sales Data worksheet tab 

5 Select cell C2 

6 Change the value to 8 

7 Select cell D2 

8 Change the value to 176000 

9 Click the Refresh worksheet tab 

10 Observe the PivotTable  
 
Notice that the figures have not changed! 

11 From the Analyze Ribbon, select the drop-down arrow below the Refresh command 
 

 

12 Select Refresh All 

13 Observe the changes to your PivotTable 
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Note:  In this example we refreshed all the PivotTables in the workbook, if we had 
wished to refresh just this table, we could have just chosen refresh 

b. Change Data Source 

With the 2 - Refresh Data.xlsx workbook still open: 

1 Click the Sales Data worksheet tab 

2 In row 501 enter the following data: 

 

3 Click the Change Source Data worksheet tab 

4 Right click the pivot table and attempt to refresh the data 
 
Notice the data does not change 

5 If necessary, select the Analyze tab 

6 From the Data group, click Change Data Source 
 

 
The Change PivotTable Data Source dialog box appears, the Table/Range has a 
grey shadow which means that you are ready to replace the range there 

7 Select any cell in the data table 

8 Press CTRL + A to select all the data in the table. 

9 Click OK 

10 Observe the changes made to your PivotTable 

Note:  If you are working with a set of data that is frequently changing in size, using the 
Change PivotTable Data Source tool is time consuming.  If you base a PivotTable on an 
Excel Table object (See our working with data course), then you no longer need to 
perform this step, you can instead just use the Refresh tool whenever your data changes 

3 Working with Filters 

To analyse our data effectively sometimes we will need to filter the data to the information 
that we are most interested in.  Excel 2016 offers several different ways that we can filter 
our data.   
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a. Filter by Report 

To filter a Pivot Table by report we place at least one field within the Filters area.  This will 
allow us to filter the entire pivotable. 

1 Open the 3 – Filter Pivot Table.xlsx file from the practice folder 

2 Select the Filters worksheet tab 

3 Click one of the cells within the displayed pivot table 

4 Within the PivotTable Fields pane on the right-hand side of the application, drag the 
Car Type field into the Filters area 
 

 
 
Above the pivot table a filter control will appear 
 

 

5 Click the drop-down control and apply a filter that shows only 3 Series related 
records 
 

 

6 Click OK 

7 Observe the changes to your pivot table 

8 Click the drop-down control again 
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9 Click the Select Multiple Items control 
 

 

10 Click the 5 series check box 

11 Click OK 

12 Observe the changes made to the pivot table 

b. Show Report Filter Pages 

Excel 2016 is able to produce multiple PivotTable that replicate a pivot table for each 
unique item in a field. This feature requires that you first add a field to the Filters area of 
your pivot table as we did previously 

1 From the Analyze ribbon, click the drop-down control to the right of the Options 
control 
 

 

2 From the menu that appears, select Show Report Filter Pages… 

3 From the Show Report Filter Pages dialogue box select the field that you wish to 
use (if not already selected) 
 

 

4 Click OK 
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5 Observe the worksheet tabs at the bottom of the worksheet 
 

 
Additional worksheets have been created, if there were already filters applied to the 
original PivotTable, then the selected filters will determine what and how many 
worksheets are created. 

c. Filter by Row or Column Labels 

Within your Pivot Tables there are filter controls that can be used to filter your data 

 

Clicking on these will offer a number of choices for both sorting and filtering these 
columns.  Where a Row or Column contains more than one filed there will be a Select 
field: control to allow you to choose what filed will be sorted or filtered. 

 

1 Click into the pivot table (if required) 

2 Click the drop-down control on the Row Labels 
 

 

Filter Controls 
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3 From the drop down that appears untick (Select All) 
 

 

4 Tick South and West 
 

 

5 Click OK 

6 Observe the changes to your pivot table 

7 Click the drop-down control on the Column Labels 

8 From the dropdown that appears, select Label Filters and then Between… 
 

 

9 Fill the dialogue as follows: 
 

 

10 Observe the changes to your pivot table 
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d. Filter by custom lists 

e. Clearing Filters 

All the filter controls that we have examined so far have had a control within that allows 
you to clear the filters applied. 

 

Generally, these clear filter controls will remove the filter from that specific column, row or 
report.  You can also use the Clear menu to clear all filters that are currently applied to 
your pivot 

With the current pivot table selected: 

1 Click Clear from the Actions group of the Analyze ribbon 
 

  

2 Select Clear Filters 

3 Observe the changes to your pivot tables 

4 Slicers and Timelines 

As well as being able to filter your data using PivotTable filters Excel 2016 offers other 
more visual and touch friendly set of tools to achieve the same. 

a. Using Slicers 

Slicers are used to filter a pivot table based on the labels contained within a field.   

1 Click the Filter by Slicer worksheet tab 

2 If required, click any cell within the PivotTable that is there 
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3 From the Analyze ribbon, click Insert Slicer 
 

 

4 From the Insert Slicers dialogue box, tick Car Type and Region 

5 The slicers will appear, you can move them using a drag and drop action with your 
mouse 

6 Click on the East button on the Region slicer 

7 Observe the changes to your pivot table 

8 With the CTRL key held down on your keyboard, Click on the North button on the 
Region slicer 

9 Observe the changes to your pivot table 

10 Click the 3 Series button on the Car Type slicer 

11 Observe the changes to your pivot table 

12 Within the region slicer click the clear control  

13 Observe the changes to your pivot table 

b. Using Timelines 

1 Select the Filter by Timeline worksheet tab 

2 If required select one of the cells of the pivot table 

3 From the Analyze ribbon, select Insert Timeline command from the Filter group 
 

 

4 Tick the Date box in the Insert Timelines dialogue box 

5 Click OK 
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6 From the timeline control that appears,  click on May 2019 
 

 

7 Using the sliders adjust the selected months to include Mar – May 2019 
 

 

8 Observe the changes in the pivot table 

5 Grouping Tools 

Among the function of Pivot Tables is that you can group items that you are analysing 
using the Group Open the  

a. Group by Label 

Grouping by label is a useful feature that allows you to group the pivot table results 
according to discrete labels.  For instance, using this tool you could group geographical 
regions into larger regions .i.e. North + West = NorthWest  

1 Open the 5 - Grouping Pivot Tables .xlsx file from you practice files folder. 

2 Click on the Label worksheet tab  

3 Arrange the pivot table to look like this: 
 

 

4 Select the North and East row labels 
 

Sum of Sales Column Labels

Row Labels 3 Series 5 Series 7 Series Grand Total

East 1596000 2024000 3640000 7260000

North 1288000 3102000 3080000 7470000

South 1694000 2596000 3465000 7755000

West 2338000 3674000 6020000 12032000

Grand Total 6916000 11396000 16205000 34517000
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Hint:  You can make a multiple selection by clicking on the North label and then with 
the CTRL key held down click on the West label.  Don’t worry if the whole row is 
selected, the next step will still work. 

5 From the Analyze ribbon, click Group Selection 
 

 
A group named Group 1 will be created 

6 Select the non-bolded East and South row labels 
 

 

7 From the Analyze ribbon, click Group Selection 
 

 
A group named Group 2 will be created 

b. Rename a Group 

When you create groups by grouping row or column labels the groups created are given 
generic labels.  You can edit these labels to something more representative. 

1 Click on the Group 1 row label 

2 Type North West 

3 Click on the Group 2 row label 

4 Type South East 
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c. Group by Number 

With the 3 - Grouping Pivot Tables .xlsx file (still open) 

1 Select the Numeric worksheet from the tabs at the bottom of the worksheet 

2 Click one of the labels in the Row Labels column 

3 From the Analyze ribbon, select Group Selection from the Group field 

4 In the dialogue box that appears fill in the following: 
 

 

5 Observe the changes to the pivot table and its pivot chart 

d. Group by Date 

With the 3 - Grouping Pivot Tables .xlsx file (still open) 

1 Select the Date worksheet using the tabs at the bottom of the app 

2 Using the PivotTable Fields pane, drag the Date field into the Rows area 

3 Observe that the dates are automatically grouped into Months 

4 Click on any of the row labels in the PivotTable 

5 From the Analyze ribbon select Ungroup 

6 From the Analyze ribbon select Group Selection 

7 Select Quarters and Years 

8 Click OK 

6 Sorting Pivot Tables 

You may find that the order that rows or columns are organised within your PivotTables 
may not be to your liking, these can be altered by using Sort tools. 
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a. Sort manually 

One of the more basic options open to you when it comes to sorting you pivot table is to 
manually move a row or column 

1 Open the 6 – Sorting Pivot Tables.xlsx file 

2 Click to select the North row label 
 

 

3 Hover your mouse over the green outside edge of selected cell. 
 
You will see the mouse pointer change to a four-way arrow. 

4 Left mouse click, hold and drag it to the position you want (i.e. upwards to the first 
row) 
 

 
The green line will move to show you the new location for the row. 

5 Observe the order of the regions will now change 

6 Click on the 2014 column header.   

7 Hover over the green border of the cell until you see the four arrows. 

8 Left mouse click, hold and drag it to the position you want (i.e. all the way to the 
right) 
 

 

9 Observe the order of the years has now changed 

10 Click in the East row header 
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11 Start typing South, hit ENTER when you see South appear 
 

 

12 Observe the South and East rows swap places 

b. Sort Ascending/Descending 

With the 6 – Sorting Tools.xlsx currently open: 

1 Click the Descending worksheet tab 

2 Click the Row Labels drop down arrow 
 

 

3 Select Largest to Smallest 

4 Observe the changes that are made to the row labels 

c. Sort by Date 

With the 6 – Sorting Tools.xlsx currently open: 

1 Click the Descending worksheet tab 

2 Click the Row Labels drop down arrow 
 

 

3 Click Sort Newest to Oldest 

4 Observe the changes that are made to the row labels 
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7 Calculated Items and Fields 

Excel 2016 allows you to perform other calculations from within your pivot table in the form 
of Calculated Items or Calculated Fields. 

a. Insert a calculated field 

In this example we will create a calculated field that reports commission paid to sales 
people. 

1 Open the 7 – Calculated Items and Fields.xlsx workbook 

2 Select the Calculated Fields worksheet 

3 Click Fields, Items & Sets 

4 From the drop-down menu that appears, select Calculated Field… 
 

 

5 In the Name: field, type Commission 

6 In the Formula: field, type = Sales * 5% 

7 Click OK 

8 Observe the changes that are made in the PivotTable 

b. Insert a calculated item 

Using the 7 – Calculated Items and Fields.xlsx worksheet still open: 

1 Click the Calculated Items worksheet tab 

2 Click on any one of the row labels 

3 Click the Analyze ribbon 

4 Click Fields, Items & Sets 
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5 From the drop-down menu that appears, select Calculated Item… 
 

 

6 In the Name: field type NorthWest 

7 In the Formula field type = North + West 

8 Click OK 

9 Observe the changes that occur to the PivotTable, The NorthWest item has been 
added, however the Grand Total has been increased.  Obviously in this case the 
Grand Total is now wrong 

8 Altering the Appearance of a PivotTable 

a. Format a field 

As well as being able to alter the calculation that occurs in the Σ Values area of the 
PivotTable we are also able alter the formatting of the displayed answers.  You can format 
the individual cells to your liking, but it is easier and more consistent to format the field 
itself. 

1 Open the 8 – Format a Pivot Table.xlsx workbook 

2 Click the Formatting worksheet tab 

3 Click on cell C6 (a cell that has a calculated value in it)  

4 From the Analyze ribbon, select Field Settings 
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5 From the Value Field Settings dialogue box click Number Format 
 

 

6 From the Format Cells dialogue box that appears select Currency 

7 Change the Decimal places to 0 
 

 

8 Click OK to close the Format Cells dialogue box 

9 Click OK to close the Value Filed Settings dialogue box 

b. Highlight Cell Rules based on values 

A great way to highlight values within your data set, Excel Table or Pivot Table is to use 
Conditional Formatting rules. 

When your criteria reference a cell, then you can make this conditional format interactive.   

1 Select the C6 cell in your Pivot Table. 

2 From the Home Ribbon select Conditional Formatting 
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3 From the menu that appears select New Rule 
 

 

4 In the Apply Rule To section select All cells showing “Sum of Sales” values for 
“Salesperson” and “Year” 

5 In the Format Style dropdown select 3-Color Scale 
 

 

6 Click OK 

7 Observe the changes to the PivotTable 

c. Subtotals 

To alter the appearance of your  

1 Click the Design tab 

2 Click the Subtotals button 
 

 

3 From the menu that appears select Show all subtotals at Bottom of Group 



 

Excel: Pivot tables (V1.1) 29 

4 Observe the change that occurs in the PivotTable 

d. Grand Totals 

From Design Ribbon still open: 

1 Click Grand Totals 

2 Select On for Rows Only 
 

 

3 Observe the results 

e. Report Layouts 

From the Design Ribbon still open: 

1 Select Report Layout 
 

 

2 Select Show in Tabular form 

3 Observe the results 

4 Try some of the other options from the Report Layout menu 

f. Pivot Table Styles 
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The overall appearance of the PivotTable can be altered by adjusting the PivotTable Style 
Options or selecting a PivotTable Style 

g. Show/Hide Pivot Table Controls 

You may prefer your PivotTables to be simplified once you are happy with the layout and 
design 

 

1 From the Design Ribbon click Field List 

2 Click the +/- Buttons control 

3 Click the Field Headers control 

4 Observe the changes that have occurred in the PivotTable 

9 Pivot Table Related Functions 

a. GETPIVOTDATA 

The GETPIVOTDATA function can be used to extract answers from a PivotTable 

You can type the function within a cell, or use the Insert Function tool to build the formula.  
However, it is much easier to create the calculation like this: 

1 Open the 8 – Pivot Table Functions.xlsx workbook 

2 Click the Analyze tab 

3 From the PivotTable group select the drop-down arrow to the right of the Options 
command 
 

 

4 From the menu that appears, check that the Generate GetPivotData option is 
ticked, if not click it so that a tick appears 

5 Select the cell F3 (where you would like the answer to appear) 
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6 Type =  

7 Click the B11 cell within the pivot table 
 
Observe the formula that is created 

8 Hit ENTER 

9 Repeat this action to calculate the Total Sunshine 

10 Working with Data Models 

Data Models are a recently added feature within Excel.  They allow you to effectively join 
together more than one data source and report on their data  

To use this feature, your data must be arranged in Tables.  The creation of tables is 
covered in a different course. 

1 Open the  – Data Models.xlsx 

In our example we have two tables containing source data, the student_data table 
and the grade_data table 

The grade_data table contains fields named Student ID and Grade 

The student_data table contain fields named Student ID, Student First Name and 
School 

Neither of the two tables in themselves allow us to perform meaningful analysis,  
however there is a relationship between the data in each table. Data Models allow us 
to describe that relationship to Excel and for Excel to then perform analysis. 

2 Click on the Grades worksheet 

3 Click any cell within the grade_data table 

4 Click the Insert Tab 

5 Click PivotTable 

6 Click Add this data to the Data Model 
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7 Click OK 

8 Observe the PivotTable Fields pane on the right and side of the screen.   
 

 

When you create a pivot table using the Data Model you can then add additional 
tables to the Data Model. 

9 Click on the All control 
 

 
 
The student_data table will appear.  If you need to you can expand any of the tables 
to see their related fields by clicking the corresponding > symbols 
 

 

10 Drag the Grade field into the Values area 

11 Drag the Student First Name field into the Rows area 
 
The Pivot Table will respond, but the answers it gives you make no sense. At this 
point Excel does not understand the relationship between the two tables.   
 
You will also see a yellow dialog appear near the top of the PivotTable Fields pane 
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12 Click the CREATE… button 
 
Note:  In this case the Auto-Detect feature would correctly guess the relationship 
between the two tables.  However, depending on the complexity of the tables you 
are adding to a data model you may experience varying results when using your own 
data. 

13 Complete the dialog box that appears like this: 
 

 

14 If you look at the pivot table now, there will be some changes to the report.  Have a 
look at the Mia row, this answer has been created because there are two people with 
that name 

15 Drag the School field above the Student First Name in the Rows area 

16 Drag the Student First Name field out of the Rows area 

17 Change the calculation of the Grades to an average. 

11 Creating a Pivot chart Report 

A Pivot chart report must be associated with a Pivot table report in the same workbook.  If 
your workbook doesn't contain a Pivot table report, Microsoft Excel creates one when you 
create the Pivot chart report.  When you change a Pivot chart report, the Pivot table report 
changes and vice versa. 

When you use the Pivot chart option, Excel creates an associated Pivot table report in the 
location you specify (on the existing worksheet or on a new worksheet in the same 
workbook). 
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The Pivot table report uses the layout that you specify for the Pivot chart report: Category 
fields in the chart are row fields in the table and series fields in the chart are column fields 
in the table. 

When you create a Pivot chart report that is based on an existing Pivot table report, the 
fields in the chart are laid out like the fields in the Pivot table report: row fields in the table 
become category fields in the chart and column fields in the table become series fields in 
the chart. 

 Creating a Pivot chart with a Pivot table 

1 Open the 11 – Create a PivotChart.xlsx file 

2 Click the PivotChart from Table worksheet tab 

3 Sit your cursor anywhere in the Table 

4 Choose the Insert tab, Charts group, and select Pivot chart 
 

 

5 Make sure the range of cells you want to use is selected and decide if you want the 
chart on a new sheet or existing worksheet 
 

 

6 When you click OK you will see – 

 



 

Excel: Pivot tables (V1.1) 35 

  

 

 1 The area where the Pivot table will be placed 

 

2 Information box indicating how to build the chart 

 

3 Field list allowing you to place fields in the appropriate chart area 
 

7 Place the field in the PivotTable Areas as shown: 
 

 

 Creating a Pivot chart from an existing Pivot table 

1 Click the PivotChart from PivotTable worksheet tab 

2 Sit your cursor in the PivotTable 

3 Choose Analyze tab, Tools group and click the PivotChart control 

1 2
1 

3
1 
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4 Choose the most appropriate option, in this case we will select a Clustered Column 

5 The Chart will display close to the table 

 

Note, you cannot use the following chart types – xy (scatter), bubble or stock.  If you try 
you will see – 
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Useful Shortcut keys 

Using keyboard shortcuts can help you become more efficient when creating documents in 
Microsoft applications.  Most keyboard shortcuts require you to use two or more keys at the 
same time.  To use a keyboard shortcut first press and hold down the modifier key or keys (i.e. 
SHIFT, CTRL, ALT) and then press the corresponding standard key on your keyboard. 

Function Shortcut 

Go to "Tell me what you want to do" ALT+Q 

Open CTRL+O 

Save CTRL+S 

Close CTRL+W 

Cut CTRL+X 

Copy CTRL+C 

Paste CTRL+V 

Select all CTRL+A 

Bold CTRL+B 

Italic CTRL+I 

Underline CTRL+U 

Cancel Esc 

Undo CTRL+Z 

Re-do CTRL+Y 

Create a Pivot Table Alt + N + V 

Group Selected Pivot Table Items Alt + Shift + Right Arrow 

Ungroup Selected Pivot Table Items Alt + Shift + Left Arrow 
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	 Create Pivot Tables and Charts to manipulate data.
	 Work with Data Models to integrate data from multiple tables

	Excel: Pivot tables
	1 Using a Pivot table or Pivot chart to analyse data
	a. Creating a Pivot table Report
	1 Open the 1 – Create Pivot Table.xlsx file from your practice folder
	2 Place your selection anywhere within the table of data
	3 On the Insert tab, Tables group, choose Pivot table     The data range 'Sales Data'!$A$1:$F$500 should be selected in the Table/Range: field
	3 On the Insert tab, Tables group, choose Pivot table     The data range 'Sales Data'!$A$1:$F$500 should be selected in the Table/Range: field
	4 Check that the Choose where the Pivot table is to be placed setting is set to New Worksheet.
	5 Click OK
	6 The Pivot table outline now appears
	7 The Pivot table task pane also appears –

	b. The Pivot table tab
	Analyze
	Design

	c. Layout a Pivot Table
	Σ Values
	1 Drag the Sales field (numerical data) into the Σ Values area  Observe the calculation that has occurred
	2 Drag the Salesperson field (text) into the Σ Values area  Observe the calculation that has occurred
	3 Drag the Count of Salesperson field from the Σ Values area and drop it either back in the fields list or outside the PivotTable Fields pane altogether

	Rows and Columns
	1 Drag the Salesperson field into the Rows area from the Fields list above  Observe the changes made to the pivot table
	2 Drag the Year field into the Columns area  Observe the changes made to the pivot table
	3 Drag the Region field into the Rows area, drop it just above the Salesperson field that is already there    Observe the changes made to the pivot table
	4 Drag the Car Type field below the Salesperson field   Observe the changes made to the pivot table
	5 Click on the Car Type field
	6 From the menu that appears click Remove Field  You can also remove a field by dragging it out of the areas all together.


	d. Rename a Pivot Table
	 The PivotTable name may not begin with a number, letter or symbol
	 The name cannot contain spaces
	1 If it is not open, click on the Analyze Tab
	2 From the PivotTable group click the PivotTable Name: text box
	3 Type “sales_pivot”
	4 Hit “ENTER”

	e. Change the Calculation
	1 Click any of the figures in the Sum of Sales area of your PivotTable
	2 In the Analyze ribbon, observe that the Active Field is the Sum of Sales.
	3 Click the Field Settings. control just below.   The Value Field Settings dialogue box will appear.  The Summarize value field by control allows you to select the calculation that will be performed in the PivotTable
	4 Select Average from the list  Notice that the Custom Name: control has changed to Average of Sales
	5 Edit the Custom Name: to read just “Average”
	6 Click OK  Observe the result
	7 Click the Field Settings control again.
	8 Change the Summarize value field by setting to Sum
	9 Click the Show Values As tab
	10 Try selecting % of Parent Row Total
	11 Click OK  Observe the result
	12 At the far-right side of the screen, drag the Sales field from the list to the Σ Values area  Notice that you now have two columns of results for each year

	f. Show Details (Drilling down)
	1 Click on one of the totals in the open pivot table to select it
	2 Right click the cell
	3 From the menu that appears select Show Details
	4 Observe the new table of data that is created


	2 Refresh Pivot Tables
	a. Refresh
	1 Open the 2 - Refresh Data.xlsx file
	2 Click on the Refresh tab to select the worksheet
	3 Note the Grand Totals for the PivotTable
	4 Click the Sales Data worksheet tab
	5 Select cell C2
	6 Change the value to 8
	7 Select cell D2
	8 Change the value to 176000
	9 Click the Refresh worksheet tab
	10 Observe the PivotTable   Notice that the figures have not changed!
	11 From the Analyze Ribbon, select the drop-down arrow below the Refresh command
	12 Select Refresh All
	13 Observe the changes to your PivotTable

	b. Change Data Source
	1 Click the Sales Data worksheet tab
	2 In row 501 enter the following data:
	3 Click the Change Source Data worksheet tab
	4 Right click the pivot table and attempt to refresh the data  Notice the data does not change
	5 If necessary, select the Analyze tab
	6 From the Data group, click Change Data Source   The Change PivotTable Data Source dialog box appears, the Table/Range has a grey shadow which means that you are ready to replace the range there
	7 Select any cell in the data table
	8 Press CTRL + A to select all the data in the table.
	9 Click OK
	10 Observe the changes made to your PivotTable


	3 Working with Filters
	a. Filter by Report
	1 Open the 3 – Filter Pivot Table.xlsx file from the practice folder
	2 Select the Filters worksheet tab
	3 Click one of the cells within the displayed pivot table
	4 Within the PivotTable Fields pane on the right-hand side of the application, drag the Car Type field into the Filters area    Above the pivot table a filter control will appear
	5 Click the drop-down control and apply a filter that shows only 3 Series related records
	6 Click OK
	7 Observe the changes to your pivot table
	8 Click the drop-down control again
	9 Click the Select Multiple Items control
	10 Click the 5 series check box
	11 Click OK
	12 Observe the changes made to the pivot table

	b. Show Report Filter Pages
	1 From the Analyze ribbon, click the drop-down control to the right of the Options control
	2 From the menu that appears, select Show Report Filter Pages…
	3 From the Show Report Filter Pages dialogue box select the field that you wish to use (if not already selected)
	4 Click OK
	5 Observe the worksheet tabs at the bottom of the worksheet   Additional worksheets have been created, if there were already filters applied to the original PivotTable, then the selected filters will determine what and how many worksheets are created.

	c. Filter by Row or Column Labels
	1 Click into the pivot table (if required)
	2 Click the drop-down control on the Row Labels
	3 From the drop down that appears untick (Select All)
	4 Tick South and West
	5 Click OK
	6 Observe the changes to your pivot table
	7 Click the drop-down control on the Column Labels
	8 From the dropdown that appears, select Label Filters and then Between…
	9 Fill the dialogue as follows:
	10 Observe the changes to your pivot table

	d. Filter by custom lists
	e. Clearing Filters
	1 Click Clear from the Actions group of the Analyze ribbon
	2 Select Clear Filters
	3 Observe the changes to your pivot tables


	4 Slicers and Timelines
	a. Using Slicers
	1 Click the Filter by Slicer worksheet tab
	2 If required, click any cell within the PivotTable that is there
	3 From the Analyze ribbon, click Insert Slicer
	4 From the Insert Slicers dialogue box, tick Car Type and Region
	5 The slicers will appear, you can move them using a drag and drop action with your mouse
	6 Click on the East button on the Region slicer
	7 Observe the changes to your pivot table
	8 With the CTRL key held down on your keyboard, Click on the North button on the Region slicer
	9 Observe the changes to your pivot table
	10 Click the 3 Series button on the Car Type slicer
	11 Observe the changes to your pivot table
	12 Within the region slicer click the clear control
	12 Within the region slicer click the clear control
	13 Observe the changes to your pivot table

	b. Using Timelines
	1 Select the Filter by Timeline worksheet tab
	2 If required select one of the cells of the pivot table
	3 From the Analyze ribbon, select Insert Timeline command from the Filter group
	4 Tick the Date box in the Insert Timelines dialogue box
	5 Click OK
	6 From the timeline control that appears,  click on May 2019
	7 Using the sliders adjust the selected months to include Mar – May 2019
	8 Observe the changes in the pivot table


	5 Grouping Tools
	a. Group by Label
	1 Open the 5 - Grouping Pivot Tables .xlsx file from you practice files folder.
	2 Click on the Label worksheet tab
	3 Arrange the pivot table to look like this:
	4 Select the North and East row labels   Hint:  You can make a multiple selection by clicking on the North label and then with the CTRL key held down click on the West label.  Don’t worry if the whole row is selected, the next step will still work.
	5 From the Analyze ribbon, click Group Selection   A group named Group 1 will be created
	6 Select the non-bolded East and South row labels
	7 From the Analyze ribbon, click Group Selection   A group named Group 2 will be created

	b. Rename a Group
	1 Click on the Group 1 row label
	2 Type North West
	3 Click on the Group 2 row label
	4 Type South East

	c. Group by Number
	1 Select the Numeric worksheet from the tabs at the bottom of the worksheet
	2 Click one of the labels in the Row Labels column
	3 From the Analyze ribbon, select Group Selection from the Group field
	4 In the dialogue box that appears fill in the following:
	5 Observe the changes to the pivot table and its pivot chart

	d. Group by Date
	1 Select the Date worksheet using the tabs at the bottom of the app
	2 Using the PivotTable Fields pane, drag the Date field into the Rows area
	3 Observe that the dates are automatically grouped into Months
	4 Click on any of the row labels in the PivotTable
	5 From the Analyze ribbon select Ungroup
	6 From the Analyze ribbon select Group Selection
	7 Select Quarters and Years
	8 Click OK


	6 Sorting Pivot Tables
	a. Sort manually
	1 Open the 6 – Sorting Pivot Tables.xlsx file
	2 Click to select the North row label
	3 Hover your mouse over the green outside edge of selected cell.  You will see the mouse pointer change to a four-way arrow.
	4 Left mouse click, hold and drag it to the position you want (i.e. upwards to the first row)   The green line will move to show you the new location for the row.
	5 Observe the order of the regions will now change
	6 Click on the 2014 column header.
	7 Hover over the green border of the cell until you see the four arrows.
	8 Left mouse click, hold and drag it to the position you want (i.e. all the way to the right)
	9 Observe the order of the years has now changed
	10 Click in the East row header
	11 Start typing South, hit ENTER when you see South appear
	12 Observe the South and East rows swap places

	b. Sort Ascending/Descending
	1 Click the Descending worksheet tab
	2 Click the Row Labels drop down arrow
	3 Select Largest to Smallest
	4 Observe the changes that are made to the row labels

	c. Sort by Date
	1 Click the Descending worksheet tab
	2 Click the Row Labels drop down arrow
	3 Click Sort Newest to Oldest
	4 Observe the changes that are made to the row labels


	7 Calculated Items and Fields
	a. Insert a calculated field
	1 Open the 7 – Calculated Items and Fields.xlsx workbook
	2 Select the Calculated Fields worksheet
	3 Click Fields, Items & Sets
	4 From the drop-down menu that appears, select Calculated Field…
	5 In the Name: field, type Commission
	6 In the Formula: field, type = Sales * 5%
	7 Click OK
	8 Observe the changes that are made in the PivotTable

	b. Insert a calculated item
	1 Click the Calculated Items worksheet tab
	2 Click on any one of the row labels
	3 Click the Analyze ribbon
	4 Click Fields, Items & Sets
	5 From the drop-down menu that appears, select Calculated Item…
	6 In the Name: field type NorthWest
	7 In the Formula field type = North + West
	8 Click OK
	9 Observe the changes that occur to the PivotTable, The NorthWest item has been added, however the Grand Total has been increased.  Obviously in this case the Grand Total is now wrong


	8 Altering the Appearance of a PivotTable
	a. Format a field
	1 Open the 8 – Format a Pivot Table.xlsx workbook
	2 Click the Formatting worksheet tab
	3 Click on cell C6 (a cell that has a calculated value in it)
	4 From the Analyze ribbon, select Field Settings
	5 From the Value Field Settings dialogue box click Number Format
	6 From the Format Cells dialogue box that appears select Currency
	7 Change the Decimal places to 0
	8 Click OK to close the Format Cells dialogue box
	9 Click OK to close the Value Filed Settings dialogue box

	b. Highlight Cell Rules based on values
	1 Select the C6 cell in your Pivot Table.
	2 From the Home Ribbon select Conditional Formatting
	3 From the menu that appears select New Rule
	4 In the Apply Rule To section select All cells showing “Sum of Sales” values for “Salesperson” and “Year”
	5 In the Format Style dropdown select 3-Color Scale
	6 Click OK
	7 Observe the changes to the PivotTable

	c. Subtotals
	1 Click the Design tab
	2 Click the Subtotals button
	3 From the menu that appears select Show all subtotals at Bottom of Group
	4 Observe the change that occurs in the PivotTable

	d. Grand Totals
	1 Click Grand Totals
	2 Select On for Rows Only
	3 Observe the results

	e. Report Layouts
	1 Select Report Layout
	2 Select Show in Tabular form
	3 Observe the results
	4 Try some of the other options from the Report Layout menu

	f. Pivot Table Styles
	g. Show/Hide Pivot Table Controls
	1 From the Design Ribbon click Field List
	2 Click the +/- Buttons control
	3 Click the Field Headers control
	4 Observe the changes that have occurred in the PivotTable


	9 Pivot Table Related Functions
	a. GETPIVOTDATA
	1 Open the 8 – Pivot Table Functions.xlsx workbook
	2 Click the Analyze tab
	3 From the PivotTable group select the drop-down arrow to the right of the Options command
	4 From the menu that appears, check that the Generate GetPivotData option is ticked, if not click it so that a tick appears
	5 Select the cell F3 (where you would like the answer to appear)
	6 Type =
	7 Click the B11 cell within the pivot table  Observe the formula that is created
	8 Hit ENTER
	9 Repeat this action to calculate the Total Sunshine


	10 Working with Data Models
	1 Open the  – Data Models.xlsx
	2 Click on the Grades worksheet
	3 Click any cell within the grade_data table
	4 Click the Insert Tab
	5 Click PivotTable
	6 Click Add this data to the Data Model
	7 Click OK
	8 Observe the PivotTable Fields pane on the right and side of the screen.
	9 Click on the All control    The student_data table will appear.  If you need to you can expand any of the tables to see their related fields by clicking the corresponding > symbols
	10 Drag the Grade field into the Values area
	11 Drag the Student First Name field into the Rows area  The Pivot Table will respond, but the answers it gives you make no sense. At this point Excel does not understand the relationship between the two tables.    You will also see a yellow dialog ap...
	12 Click the CREATE… button  Note:  In this case the Auto-Detect feature would correctly guess the relationship between the two tables.  However, depending on the complexity of the tables you are adding to a data model you may experience varying resul...
	13 Complete the dialog box that appears like this:
	14 If you look at the pivot table now, there will be some changes to the report.  Have a look at the Mia row, this answer has been created because there are two people with that name
	15 Drag the School field above the Student First Name in the Rows area
	16 Drag the Student First Name field out of the Rows area
	17 Change the calculation of the Grades to an average.

	11 Creating a Pivot chart Report
	Creating a Pivot chart with a Pivot table
	1 Open the 11 – Create a PivotChart.xlsx file
	2 Click the PivotChart from Table worksheet tab
	3 Sit your cursor anywhere in the Table
	4 Choose the Insert tab, Charts group, and select Pivot chart
	5 Make sure the range of cells you want to use is selected and decide if you want the chart on a new sheet or existing worksheet
	6 When you click OK you will see –
	7 Place the field in the PivotTable Areas as shown:

	Creating a Pivot chart from an existing Pivot table
	1 Click the PivotChart from PivotTable worksheet tab
	2 Sit your cursor in the PivotTable
	3 Choose Analyze tab, Tools group and click the PivotChart control
	4 Choose the most appropriate option, in this case we will select a Clustered Column
	5 The Chart will display close to the table


	Useful Shortcut keys

